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Unity PURJet 30 Dispensing System

Safety 
Read this section before using the equipment. This section contains
recommendations and practices applicable to the safe installation, operation,
and maintenance (hereafter referred to as “use”) of the product described in
this document (hereafter referred to as “equipment”). Additional safety
information, in the form of task‐specific safety alert messages, appears as
appropriate throughout this document.

WARNING! Failure to follow the safety messages, recommendations, and
hazard avoidance procedures provided in this document can result in
personal injury, including death, or damage to equipment or property.

Safety Alert Symbols 

The following safety alert symbol and signal words are used throughout this
document to alert the reader to personal safety hazards or to identify
conditions that may result in damage to equipment or property. Comply with
all safety information that follows the signal word.

WARNING! Indicates a potentially hazardous situation that, if not avoided,
can result in serious personal injury, including death.

CAUTION! Indicates a potentially hazardous situation that, if not avoided,
can result in minor or moderate personal injury.

CAUTION! (Used without the safety alert symbol) Indicates a potentially
hazardous situation that, if not avoided, can result in damage to equipment or
property.
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Responsibilities of the Equipment Owner 

Equipment owners are responsible for managing safety information, ensuring
that all instructions and regulatory requirements for use of the equipment are
met, and for qualifying all potential users.

Safety Information 
� Research and evaluate safety information from all applicable sources,

including the owner‐specific safety policy, best industry practices,
governing regulations, material manufacturer's product information, and
this document.

� Make safety information available to equipment users in accordance with

governing regulations. Contact the authority having jurisdiction for
information.

� Maintain safety information, including the safety labels affixed to the

equipment, in readable condition.

Instructions, Requirements, and Standards 
� Ensure that the equipment is used in accordance with the information

provided in this document, governing codes and regulations, and best
industry practices.

� If applicable, receive approval from your facility's engineering or safety

department, or other similar function within your organization, before
installing or operating the equipment for the first time.

� Provide appropriate emergency and first aid equipment.

� Conduct safety inspections to ensure required practices are being

followed.

� Re‐evaluate safety practices and procedures whenever changes are

made to the process or equipment.
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User Qualifications 

Equipment owners are responsible for ensuring that users:

� receive safety training appropriate to their job function as directed by

governing regulations and best industry practices

� are familiar with the equipment owner's safety and accident

prevention policies and procedures

� receive equipment and task‐specific training from another qualified

individual

NOTE:  Nordson can provide equipment‐specific installation,
operation, and maintenance training. Contact your Nordson
representative for information

� possess industry‐ and trade‐specific skills and a level of experience

appropriate to their job function

� are physically capable of performing their job function and are not

under the influence of any substance that degrades their mental
capacity or physical capabilities

Applicable Industry Safety Practices 

The following safety practices apply to the use of the equipment in the
manner described in this document. The information provided here is not
meant to include all possible safety practices, but represents the best safety
practices for equipment of similar hazard potential used in similar industries.

Intended Use of the Equipment 
� Use the equipment only for the purposes described and within the limits

specified in this document.

� Do not modify the equipment.

� Do not use incompatible materials or unapproved auxiliary devices.

Contact your Nordson representative if you have any questions on
material compatibility or the use of non‐standard auxiliary devices.
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Instructions and Safety Messages 
� Read and follow the instructions provided in this document and other

referenced documents.

� Familiarize yourself with the location and meaning of the safety warning

labels and tags affixed to the equipment. Refer to Safety Labels and Tags
at the end of this section.

� If you are unsure of how to use the equipment, contact your Nordson

representative for assistance.

Installation Practices 
� Install the equipment in accordance with the instructions provided in this

document and in the documentation provided with auxiliary devices.

� Ensure that the equipment is rated for the environment in which it will be

used. This equipment has not been certified for compliance with the
ATEX directive nor as nonincendive and should not be installed in
potentially explosive environments.

� Ensure that the processing characteristics of the material will not create a

hazardous environment. Refer to the Material Safety Data Sheet (MSDS)
for the material.

� If the required installation configuration does not match the installation

instructions, contact your Nordson representative for assistance.

� Position the equipment for safe operation. Observe the requirements for

clearance between the equipment and other objects.

� Install lockable power disconnects to isolate the equipment and all

independently powered auxiliary devices from their power sources.

� Properly ground all equipment. Contact your local building code

enforcement agency for specific requirements.

� Ensure that fuses of the correct type and rating are installed in fused

equipment.

� Contact the authority having jurisdiction to determine the requirement for

installation permits or inspections.

Operating Practices 
� Familiarize yourself with the location and operation of all safety devices

and indicators.

� Confirm that the equipment, including all safety devices (guards,

interlocks, etc.), is in good working order and that the required
environmental conditions exist.

� Use the personal protective equipment (PPE) specified for each task.

Refer to Equipment Safety Information or the material manufacturer's
instructions and MSDS for PPE requirements.

� Do not use equipment that is malfunctioning or shows signs of a potential

malfunction.
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Maintenance and Repair Practices 
� Allow only personnel with appropriate training and experience to operate

or service the equipment.

� Perform scheduled maintenance activities at the intervals described in

this document.

� Relieve system hydraulic and pneumatic pressure before servicing the

equipment.

� De‐energize the equipment and all auxiliary devices before servicing the

equipment.

� Use only new Nordson‐authorized refurbished or replacement parts.

� Read and comply with the manufacturer's instructions and the MSDS

supplied with equipment cleaning compounds.

NOTE:  MSDSs for cleaning compounds that are sold by Nordson are
available at www.nordson.com or by calling your Nordson representative.

� Confirm the correct operation of all safety devices before placing the

equipment back into operation.

� Dispose of waste cleaning compounds and residual process materials

according to governing regulations. Refer to the applicable MSDS or
contact the authority having jurisdiction for information.

� Keep equipment safety warning labels clean. Replace worn or damaged

labels.

Equipment Safety Information 

This equipment safety information is applicable to the following types of
Nordson equipment:

� hot melt and cold adhesive application equipment and all related

accessories

� pattern controllers, timers, detection and verification systems, and all

other optional process control devices
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Equipment Shutdown 

To safely complete many of the procedures described in this document, the
equipment must first be shut down. The level of shut down required varies by
the type of equipment in use and the procedure being completed. 
If required, shut down instructions are specified at the start of the procedure.
The levels of shut down are:

Relieving System Hydraulic Pressure 

Completely relieve system hydraulic pressure before breaking any hydraulic
connection or seal. Refer to the melter‐specific product manual for
instructions on relieving system hydraulic pressure.

De‐energizing the System 

Isolate the system (melter, hoses, applicators, and optional devices) from all
power sources before accessing any unprotected high‐voltage wiring or
connection point.

1. Turn off the equipment and all auxiliary devices connected to the
equipment (system).

2. To prevent the equipment from being accidentally energized, lock and
tag the disconnect switch(es) or circuit breaker(s) that provide input
electrical power to the equipment and optional devices.

NOTE:  Government regulations and industry standards dictate specific
requirements for the isolation of hazardous energy sources. Refer to the
appropriate regulation or standard.

Disabling the Applicators 

NOTE:  Adhesive dispensing applicators are referred to as “guns” in some
previous publications.

All electrical or mechanical devices that provide an activation signal to the
applicators, applicator solenoid valve(s), or the melter pump must be
disabled before work can be performed on or around an applicator that is
connected to a pressurized system.

1. Turn off or disconnect the applicator triggering device (pattern controller,
timer, PLC, etc.).

2. Disconnect the input signal wiring to the applicator solenoid valve(s).

3. Reduce the air pressure to the applicator solenoid valve(s) to zero; then
relieve the residual air pressure between the regulator and the applicator.
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General Safety Warnings and Cautions 

Table 1 contains the general safety warnings and cautions that apply to
Nordson hot melt and cold adhesive equipment. Review the table and
carefully read all of the warnings or cautions that apply to the type of
equipment described in this manual.

Equipment types are designated in Table 1 as follows:

HM = Hot melt (melters, hoses, applicators, etc.)

PC = Process control

CA = Cold adhesive (dispensing pumps, pressurized container, and
applicators)

Table 1 General Safety Warnings and Cautions 

Equipment
Type Warning or Caution

HM

WARNING! Hazardous vapors! Before processing any polyurethane
reactive (PUR) hot melt or solvent‐based material through a compatible
Nordson melter, read and comply with the material's MSDS. Ensure
that the material's processing temperature and flashpoints will not be
exceeded and that all requirements for safe handling, ventilation, first
aid, and personal protective equipment are met. Failure to comply with
MSDS requirements can cause personal injury, including death.

HM

WARNING! Reactive material! Never clean any aluminum component
or flush Nordson equipment with halogenated hydrocarbon fluids.
Nordson melters and applicators contain aluminum components that
may react violently with halogenated hydrocarbons. The use of
halogenated hydrocarbon compounds in Nordson equipment can
cause personal injury, including death.

HM, CA
WARNING! System pressurized! Relieve system hydraulic pressure
before breaking any hydraulic connection or seal. Failure to relieve the
system hydraulic pressure can result in the uncontrolled release of hot
melt or cold adhesive, causing personal injury.

Continued...
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General Safety Warnings and Cautions  (contd)

Table 1 General Safety Warnings and Cautions  (contd)

Equipment
Type Warning or Caution

HM

WARNING! Molten material! Wear eye or face protection, clothing that
protects exposed skin, and heat‐protective gloves when servicing
equipment that contains molten hot melt. Even when solidified, hot melt
can still cause burns. Failure to wear appropriate personal protective
equipment can result in personal injury.

HM, PC

WARNING! Equipment starts automatically! Remote triggering devices
are used to control automatic hot melt applicators. Before working on
or near an operating applicator, disable the applicator's triggering
device and remove the air supply to the applicator's solenoid valve(s).
Failure to disable the applicator's triggering device and remove the
supply of air to the solenoid valve(s) can result in personal injury.

HM, CA, PC

WARNING! Risk of electrocution! Even when switched off and
electrically isolated at the disconnect switch or circuit breaker, the
equipment may still be connected to energized auxiliary devices.
De‐energize and electrically isolate all auxiliary devices before
servicing the equipment. Failure to properly isolate electrical power to
auxiliary equipment before servicing the equipment can result in
personal injury, including death.

HM, CA, PC

WARNING! Risk of fire or explosion! Nordson adhesive equipment is
not rated for use in explosive environments and has not been certified
for the ATEX directive or as nonincendive. In addition, this equipment
should not be used with solvent‐based adhesives that can create an
explosive atmosphere when processed. Refer to the MSDS for the
adhesive to determine its processing characteristics and limitations.
The use of incompatible solvent‐based adhesives or the improper
processing of solvent‐based adhesives can result in personal injury,
including death.

Continued...
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Table 1 General Safety Warnings and Cautions  (contd)

Equipment
Type Warning or Caution

HM, CA, PC

WARNING! Allow only personnel with appropriate training and
experience to operate or service the equipment. The use of untrained
or inexperienced personnel to operate or service the equipment can
result in injury, including death, to themselves and others and can
damage to the equipment.

HM

CAUTION! Hot surfaces! Avoid contact with the hot metal surfaces of
applicators, hoses, and certain components of the melter. If contact
can not be avoided, wear heat‐protective gloves and clothing when
working around heated equipment. Failure to avoid contact with hot
metal surfaces can result in personal injury.

HM

CAUTION! Some Nordson melters are specifically designed to
process polyurethane reactive (PUR) hot melt. Attempting to process
PUR in equipment not specifically designed for this purpose can
damage the equipment and cause premature reaction of the hot melt. If
you are unsure of the equipment's ability to process PUR, contact your
Nordson representative for assistance.

HM, CA

CAUTION! Before using any cleaning or flushing compound on or in
the equipment, read and comply with the manufacturer's instructions
and the MSDS supplied with the compound. Some cleaning
compounds can react unpredictably with hot melt or cold adhesive,
resulting in damage to the equipment.

HM

CAUTION! Nordson hot melt equipment is factory tested with Nordson
Type R fluid that contains polyester adipate plasticizer. Certain hot melt
materials can react with Type R fluid and form a solid gum that can
clog the equipment. Before using the equipment, confirm that the hot
melt is compatible with Type R fluid.
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Other Safety Precautions 
� Do not use an open flame to heat hot melt system components.

� Check high pressure hoses daily for signs of excessive wear, damage, or

leaks.

� Never point a dispensing handgun at yourself or others.

� Suspend dispensing handguns by their proper suspension point.

First Aid

If molten hot melt comes in contact with your skin:

1. Do NOT attempt to remove the molten hot melt from your skin.

2. Immediately soak the affected area in clean, cold water until the hot melt
has cooled.

3. Do NOT attempt to remove the solidified hot melt from your skin.

4. In case of severe burns, treat for shock.

5. Seek expert medical attention immediately. Give the MSDS for the hot
melt to the medical personnel providing treatment.
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Safety Labels and Tags 

Figure 1 illustrates the location of the product safety labels and tags affixed to
the equipment.  Table 2 provides an illustration of the hazard identification
symbols that appear on each safety label and tag, the meaning of the
symbol, or the exact wording of any safety message.

1

2

Figure 1 Safety labels and tags

Table 2 Safety Labels and Tags 

Item Part Description

1. - - - - - -

Sign, power

2. - - - - - -

Sign, hot
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Description 
This manual describes the installation and use of the Nordson Unity
PURJet�30 dispensing system. When necessary, the reader is referred to the
documentation supplied with other Nordson products or products supplied by
third parties.

The Unity PURJet 30 dispensing system liquifies solid‐form polyurethane
reactive (PUR) hot melt adhesive contained in 30‐cc syringes and maintains
the adhesive at the desired temperature. When the system is activated, it
uses compressed air and jetting to dispense adhesive as a series of joined
dots onto the surface of a product or into a product feature, usually in a small
to mid‐sized electronics assembly application. The adhesive dots may be as
small as 1.0 mm (0.04 in.) in width. The system includes:

� the Unity controller

� the Unity PURJet 30 applicator

� the Unity PURJet 30 jet dispensing module

� a remote air treatment and muffler assembly (hereafter referred to as

the air kit)

� a Nordson Corporation or customer‐supplied robot for use with the

Unity controller and applicator  and the JR C‐Points robot software for
Windows�‐based computers (if applicable)

1

5

2

3

4

Figure 2 Unity PURJet 30 dispensing system

1. Unity controller

2. Applicator with jet module

3. Air kit

4. Air dryer

5. Robot (Nordson Corporation
robot shown)
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Intended Use 

Unity Series dispensing systems are specifically designed to:

� Melt and pump solid‐form PUR hot melt adhesives contained in

syringes that are engineered to be liquified and extruded at
temperatures below 121 �C (250 �F)

� Be used with compatible equipment manufactured by Nordson

Corporation

� Be used in non‐explosive environments

The Unity PurJet30 dispensing system is virtually complete, but is intended
to be incorporated into machinery or assemblies by an integrator. The
equipment must not be placed into use in a member state of the European
Union until the parent machinery or assemblies have been declared by the
integrator to be in conformity with the applicable directives of the European
Commission.

Limitations of Use 

Use Unity Series dispensing systems only for the purpose for which they are
designed. Unity Series dispensing systems should not be used:

� to melt or pump any material that creates a health or safety hazard

when heated

� in environments that will require the system to be cleaned using a

water wash or spray

Additional Limitations of Use for PUR Adhesives 

When the maximum level of harmful substance concentration is exceeded,
use a gas mask and air purifying equipment.
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Unit Identification 

See Figure 3. You will need the model and part number of the applicator
when requesting service or ordering spare parts and optional equipment. The
applicator model and part number are indicated on the equipment
identification plate.

Figure 3 Applicator equipment identification plate
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Key Components 

Figures 4-7 provide the name and the location of key system components.

7

8

9

2

6

5

3

1

4

10

Figure 4 Key components of the applicator and robot assemblies

1. Applicator body

2. Adhesive syringe latch

3. Heater cordset

4. Sensor cordset

5. Solenoid valve

6. Jet module (nozzle not visible)

7. Robot

8. Robot controls

9. Moving plate

10. Robot power switch (on back
of unit)
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Key Components  (contd)

1

2

5

4

3

6

Figure 5 Key components of the air kit

1. Muffler

2. Air output ports

3. Air pressure regulator and gauge

4. Water separator filter

5. Air supply input

6. Air dryer
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8

4

1

567

2 3

Figure 6 Key components of the Unity controller (front view)

1. FAULT LED

2. ALARM LED

3. READY LED

4. Display

5. Up/down arrow keys

6. SET key

7. PAGE key

8. Purge switch
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Key Components  (contd)

1

2 3 4 5

6

7

8

9

Figure 7 Key components of the Unity controller (top view)

1. Applicator connection

2. Enclosure power

3. Robot connection

4. Camera connection

5. Applicator connection

6. Connection for supply air from
regulator

7. Connection for tubing to
syringe/end cap

8. Exhaust port

9. Power switch
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Installation 
Installation involves placing the system in the desired location and making
the electrical and hydraulic connections.

Electro‐Magnetic Compliance Information 

This system is classified as Class A, Group 2 under the European standard
for limits and methods of measurement, EN 55011.

Experience of Installation Personnel

The instructions provided in this section are intended to be used by
personnel who have experience in the following subjects:

� Hot melt application processes

� Industrial power and control wiring

� Industrial mechanical installation practices

� Basic process control and instrumentation

Customer‐Supplied Installation Components 

In addition to the components provided by Nordson Corporation, installation
of the Unity PURJet 30 dispensing system requires the following
customer‐supplied components:

� 240 VAC power supply

� laptop computer

� Standard RS232 serial communication cable to connect from the

robot to the laptop computer

� appropriate guarding and signage as required to prevent personal

injury during operation and service activities
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Contents of the Ship‐With Kit 

P/N 164045

P/N 900586

1

2

3

4

P/N 982046

P/N 983401

Figure 8 Contents of the ship-with kit

1. 164045, CBL,ADPTR, 12P/6S, 10FT,
T-STYLE (used to connect the
applicator cordset to the controller)

2. 900586, TUBING, POLTHN, 6 MM OD
X 4 MM, BLUE (25 FT)

3. 982046, SCR, HEX, CAP, M5 X 14,
BL (used to install the applicator on
the robot)

4. 983401, WASHER, LK, M,
SPT, M5, STL, ZN (used to
install the applicator on the
robot)
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Position the Robot 
1. Unpack and place the robot assembly at the desired location. Consider

the following when locating the robot assembly:

� The plant's electrical service must be rated to handle the power

required by the system.

� The operator must be able to safely reach and accurately monitor

moving parts and controls.

� The equipment must be installed near a supply of clean, dry,

regulator, unlubricated compressed air.

� The equipment must be installed away from areas with strong drafts

or where sudden temperature changes occur.

� The equipment must be installed where it will be in conformance with

the ventilation requirements specified in the Material Safety Data
Sheet for the hot melt being used.

2. Install appropriate guarding and signage as required to prevent personal
injury (due to pressurized material, hot surfaces, pinch points, etc.) during
operation and service activities.
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Install the Applicator on the Robot 

See Figure 9. Use the mounting block and screws supplied with the
applicator to install the applicator on the robot.

4

2

13

Figure 9 Installing a PJ30 applicator on a robot (gantry‐style robot shown)

1. Gantry‐style robot

2. PJ30 applicator

3. 983401, WASHER, LK, M,
SPT, M5, STL, ZN

4. 982046, SCR, HEX, CAP, M5
X 14, BL
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Mount the Unity Controller 

See Figure 10. Unpack and mount the Unity controller using the four bolt
holes located on the back of the enclosure.

(10 in.)
4 PL.

254 mm

(12.75 in.)
323.9 mm

(0.313 in.)
7.95 mm

Figure 10 Unity controller bolt mounting pattern
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Make the Air Supply Connections 

See Figure 11. Using the air kit, make the air supply connections shown in
Table 3 and Figure 11. The air supply must be clean, dry, regulated,
unlubricated compressed air. Set the operating air pressure to 4.1 bar
(60�psi).

Table 3 Air Supply Connections 

Item No. in
Fig. 11

Pneumatic Connection Connect to... Then connect to...

1 Main air supply input Main air supply Air regulator input port

2 Air supply to applicator
solenoid valve

Air kit output port Top air input port (3) on
applicator solenoid valve

3 Air supply to applicator
solenoid valve

Air kit output port Bottom air input port (5) on
applicator solenoid valve

4 Air supply through air dryer
to controller

Air kit output port (T‐fitting) Air dryer input/output ports
and controller air input port

5 Air supply to applicator
solenoid valve

Air kit output port (T‐fitting) Middle air input port (1) on
applicator solenoid valve

6 Air supply to applicator
adhesive syringe

Air output port on top of
controller

Air fitting on top of
applicator adhesive syringe
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CONTROLLER TOP

APPLICATOR

6

4

6 mm

12 mm

EXHAUST PORT

AIR KIT ASSEMBLY

5

6 mmMAIN AIR
SUPPLY
SOURCE

APPLICATOR

1
10 mm

2 10 mm

3 10 mm

AIR DRYER

SOLENOID VALVE

ADHESIVE SYRINGE

Figure 11 Air supply connections (refer to Table 3)
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Connect Cables 

See Figure 12. Make the cable connections shown in the following table.

Table 4 Cable Connections 

Item No. in
Fig. 12

Cable Connect to... Then connect to...

1 Robot controller cable Already connected to
controller

I/O SYS port on the back of
the robot

2 Robot system interlock
cable

I/O‐S port on the back of the
robot

Customer system‐ready
interlock

3 Unity controller power
cable

Power input on top of Unity
controller

240 VAC power outlet

NOTE:  Do not use the
power outlet on the back of
the robot.

4 Robot power cable 240V cordset connector on
back of robot

240 VAC power outlet

5 Robot communications
cable (customer‐supplied)

COM1 connector on the front
of the robot

Serial port on
Windows‐based computer

6 Applicator cordset 6‐pin connector on the
extension cable (P/N�164045)
from the ship‐with kit

12‐pin connector on the top
of the Unity controller

7 Solenoid valve Solenoid valve connector on
top of Unity controller

Quick‐disconnect on
solenoid valve connector
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ROBOT FRONT
ROBOT BACK

I/O−S I/O SYS
COM1

12

CUSTOMER
SYSTEM-READY
INTERLOCK

3

240V

240V
OUTLET

OUTLET

45

CONTROLLER TOP

APPLICATOR TOP

COMPUTER

67

Figure 12 Cable connections (refer to Table 4)
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Unity PURJet 30 Dispensing System28

Part 1104545_06 � 12/2013 Nordson Corporation

Install Software 

Install any required software. Refer to the robot manual and/or any other
applicable documentation.

If your system includes a Nordson Corporation robot, install the JR C‐Points
robot software using the supplied software installation CD.

Perform Initial System Power On 

See Figures 4-7 as needed for the location of controls.

1. Turn on the robot.

2. Turn on the controller. The controller display will go through the startup
screens.

3. Turn on the air supply.

4. If a flush syringe is not already installed, load a flush syringe in the
applicator as follows:

a.. Open the adhesive syringe latch and remove the air cap.

b.. Remove the caps from both ends of the flush syringe and insert the
syringe into the applicator.

c.. Reinstall the air cap and close the latch.

5. If a cured adhesive warning exists at startup, reset the Elapsed Time
parameter to 0. Refer to Changing a Parameter in the User Mode under
Setup.

6. Continue to the next section, Setup, to set up the system for your
application.
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Setup 
Setup involves customizing the controller, robot, and applicator settings for
your application.

Set Up the Unity Controller 

The controller settings may be changed in two modes: user mode and
administrator mode. Use the following procedures to change the controller
settings as needed for your application.

Setting the Controller to PJ30 Operation 

On the UNIT TYPE page, select the PJ30 parameter. Refer to Changing a
Parameter in the Administrator Mode for the procedure for changing a
parameter.

Changing a Parameter in the User Mode 
1. Press PAGE until the desired parameter is displayed. Refer to Table�5 for

the parameters that can be accessed in the user mode.

2. Press SET to change the parameter.

3. Press the Up/Down arrows to scroll to the desired value.

4. Press SET to save the setting.

The display will briefly flash “Data successfully stored to memory.”

OUTPUT PRESSURE:
15.00 PSI

Figure 13 Unity controller display and keys
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Changing a Parameter in the Administrator Mode 
1. Simultaneously press and hold the Up/Down arrows for at least

5�seconds.

The display will briefly flash “Administrator Mode Enabled.”

2. Press PAGE until the desired parameter is displayed. Refer to Tables�5
and 6 for the parameters that can be accessed in the administrator mode.

3. Press SET to change the parameter.

4. Press the Up/Down arrows to scroll to the desired value.

5. Press SET to save the setting.

6. Simultaneously press and hold the Up/Down arrows for at least
5�seconds to exit the administrator mode.

The display will briefly flash “Administrator Mode Disabled.”

DISPLAYED UNITS:
ENGLISH

Figure 14 Unity controller display and keys
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NOTE:  Refer to Changing a Parameter in the User Mode under Set Up the
Unity Controller for the procedure for changing a parameter.

Table 5 Unity Controller User and Administrator Mode Parameters 

Page Function/Description

NO ALARMS OR
MESSAGES

Displayed when no alarms or messages exist.

OUTPUT PRESSURE:
XX.XX PSI

Displays the pressure setpoint and allows you to enter a pressure setpoint.

Example: 3.45 PSI

TEMPERATURE: XXX F
SETPOINT: XXX F

Displays the heater temperature and allows you to enter a temperature
setpoint.

Example: 250 F

ELAPSED TIME:
X HR, X MIN

Displays how long a syringe has been heated and allows you to reset the
timer.

Example: 1 HR 10 MIN

TIMER MODE: Allows you to place the controller in the Run or Pause mode.

Values: RUNNING or PAUSED!

PRODUCT COUNT: Displays the number of products processed. This value is accurate only if
the BEAD PER PRODUCT parameter is set correctly. To reset this
parameter, press the SET key.

Example: 3427

TEMPERATURE MODE: Allows you to place the system into the setback mode. The setback mode
reduces the temperature of the heaters by the amount entered in the
TEMP SETBACK AMOUNT parameter.

Values: NORMAL and SETBACK

GUN ON TIME:
(see Notes)

Allows you to enter the amount of the time (in ms) the applicator will open
to dispense adhesive dots when the signal from the robot is active. This
parameter is used only when the GUN OFF TIME parameter is a value
greater than 0.

Values: 0-500 (ms)

Example: 7 (ms)

GUN OFF TIME:
(see Notes)

Allows you to enter the amount of the time (in ms) the applicator will close
when the signal from the robot is active. This parameter is used only when
the GUN ON TIME parameter is a value greater than 0.

Values: 0 (STITCHING OFF) to 500 (ms)

Example: 30 (ms)

NOTE:  To preserve solenoid life, Nordson Corporation recommends setting the values for GUN ON TIME
and GUN OFF TIME at 7 ms or greater.

NOTE:  As long as the signal from the robot is active, the applicators will open for the amount of time set in
GUN ON TIME and will close for the amount of time set in GUN OFF TIME. These on/off cycles will stop
only when the signal from the robot is stopped.

NOTE:  An adhesive bead is defined as the series of adhesive dots dispensed during one applicator on‐off
cycle.
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Set Up the Unity Controller  (contd)

NOTE:  Refer to Changing a Parameter in the Administrator Mode under Set
Up the Unity Controller for the procedure for changing a parameter.

Table 6 Unity Controller Administrator Mode Only Parameters 

Page Function/Description

UNIT TYPE: Used to set the controller for PURJet 30 or IC30/IC300 dispensing system
operation.

Values: PURJet30 and IC30 (default)

TEMP SETBACK AMOUNT: Allows you to enter a temperature setback amount. When the system is
placed in the setback mode, the temperature setpoint will be reduced by
the number of degrees entered for this parameter.

Example: 100 F

DISPLAYED UNITS: Used to display pressure in metric units (bar). Pressure values must be set
in English (psi) and are internally calculated in psi.

Values: ENGLISH or METRIC

MAXIMUM PRESSURE: A warning is generated when the pressure is greater than this value.

Example: 40 PSI

BEADS PER PRODUCT:
(see Note)

Used to specify the number of adhesive beads applied to a product. This
number is then used to calculate the product count that is displayed in the
PRODUCT COUNT parameter.

Example: 2

NOTE:  An adhesive bead is defined as the series of adhesive dots dispensed during one applicator on‐off
cycle.
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Set Up the Robot Using JR C‐Points 

NOTE:  This section applies only if you are using a Nordson Corporation
robot.

NOTE:  The JR C‐Points software does not allow you to undo or redo steps.
Save your work often.

Set the Robot Communications Cable Port 

See Figure 15.

1. Open Device Manager.

2. Expand Ports (COM & LPT).

3. Determine which port the robot communications cable is connected to,
select that port, right‐click on the selection, and select Properties.

4. In the Communications Port (COM1) Properties dialog box, select the
Port Settings tab and then select Advanced.

5. Select the correct COM Port Number. Only ports COM1 to COM4 are
compatible with the JR C‐Points software.

Figure 15 Screens used to set the COM port
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Set Up the Computer Communications Link with the
Robot 
1. Select Robot > Com Status.

2. In the COM Status dialog box, select:

� Port: COM1 (or the port set up in the previous procedure)

� Parity: Non

� Stop bits: 1

Figure 16 COM Status dialog box

Initialize the Robot (As Needed) 

Select Robot > Meca Initialize. Initializing the robot resets the X and Y axes
to (0,0).
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Open a Robot Program File 
1. Open JR C‐Points by double‐clicking on the JR C‐Points for Dispensing

Icon.

2. Select File > Open.

NOTE:  For detailed JR C‐Points software programming information, refer to
the robot product manual.

Set Up Views 
1. Select View > Change View > Longitudinal View.

2. Select View > Visual Display.

The display looks like Figure 17.

Figure 17 JR C‐Points screen in longitudinal view
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Adjust the Adhesive Pattern Using the Zoom Function
(As Needed) 

See Figure 18.

1. Use the following methods to zoom in on and fine‐tune the adhesive
pattern:

� Use the Magnifier icon to zoom in on a particular location. To pan,

deselect the Magnifier icon and then click and hold with the cursor to
move the image.

� Use the Graph Grid icon to grid the graph.

NOTE:  Double‐click in the white area next to a point to center the display
on that point.

2. Click on the Refresh icon after using any of these functions to update the
display.

Magnifier

Graph Grid

Magnification %

Refresh

Figure 18 Zoom tool bar
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Move (Jog) the Robot (As Needed) 

See Figure 19.

1. Select Robot > Jog.

2. Use any of following methods to move the robot:

� Select any position button

� Press the corresponding key on the computer keyboard

NOTE:  Do not click on Register or use the Enter key. Doing so will
register the point.

� Enter the point number and select GO

� Enter the coordinates in the X and Y field and then select GO

� Select Robot > Jog; for a fast jog, press SHIFT + the corresponding

key on the keyboard (E, R, etc.)

� Select the point number and then select Robot > Go Move or Go

Move Plus

X

X Direction (Part Movement)

Z Direction (Up/Down)

Y Direction (Applicator)

Y

Figure 19 Jog screen



Robot menu
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Reprogram or Change the Adhesive Path (As Needed) 

NOTE:  If the robot has a program or a modification is desired, the
information can be downloaded from the robot.

1. Select Robot > Receive C&T Data > Receive.

2. Select Robot > Changing Mode > Teaching Mode.

3. Make the desired changes to the adhesive path.

To modify the type of point:

a.. Click on the point to be changed (9, 10, or 11 in the example shown).

b.. Select CP Passing Point, then right click and select an option.

c.. Click on the Refresh icon view the new path.

Example: Figure 20 shows a before and after diagram of the Change to
ARC Point option.

9

10

11 9

10

11

Figure 20 Example of the Change to ARC Point option

To offset points:

a.. Select the desired points and then select Edit > Offset Move.

b.. Enter values for X, Y, and Z in the Offset Move dialog box.

To insert or add a point:

� To add a point in a selected position, select the position, then select

Edit > Insert Point.

� To add a point at end of the program, select Edit > Add Point.

4. Select Robot > Send C&T Data > Send.

5. Select Robot > Changing Mode > Switch Mode to change back to the
robot mode.
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Set Up the Unity PURJet 30 Applicator 
1. Refer to Set Up the Unity Controller earlier in this section as needed to

enter the following parameters:

� GUN ON TIME: 7 (ms)

� GUN OFF TIME: 30 (ms)

� TEMP SETBACK AMOUNT: 250 �F

2. Program the robot movement and set the robot speed for less than
40�mm/s. Refer to the robot documentation as needed.

3. If the dispensing module is adjustable, set the needle stroke as follows:

a.. De‐energize the solenoid valve.

b.. Turn the needle adjustment screw clockwise just until the adjustment
contacts the needle assembly.

c.. Turn the needle adjustment screw counterclockwise two (2) full turns,
which will result in a 1 mm setting.

4. Test the system by running a product.

5. If adjustments are needed, the following steps are recommended:

a.. Change the GUN OFF TIME to 7 (ms).

b.. Program the robot movement and set the robot speed for greater than
40 mm/s. Refer to the robot documentation as needed.

c.. Test a product.

d.. Decrease the robot speed as needed until the desired adhesive bead
weight is achieved.

6. Repeat the steps in this procedure as needed, making the necessary
adjustments in values, until the applicator is performing as desired.
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Operation 
Before operating the system for the first time, ensure that you have
completed the procedures in the Installation and Setup sections.

Special Operating Considerations for PUR Adhesive 

Because the viscosity of PUR adhesive increases significantly when the
system is at operating temperature, the applicator should be heated only for
operation or cleaning. If the applicator is held at operating temperature longer
than the life of the PUR adhesive, then the risk of cured material inside the
applicator increases.

However, even in the best operating scenario it is still likely that over time the
PUR will occlude the inner adhesive passages, requiring the applicator to be
cleaned. When the applicator is cleaned, is it critical to remove cured PUR
adhesive from all adhesive passages (see Figure 26), not just the adhesive
passages inside the module. Refer to Applicator Cleaning under
Maintenance.

Daily Startup and Operation 
1. Turn on the robot.

2. Turn on the controller. The controller display will go through the startup
screens.

NOTE:  The controller always powers on in the user mode.
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3. Turn on the air supply.

4. Allow the system to reach application temperature.

5. If a cured adhesive warning exists at startup, reset the Elapsed Time
parameter to 0. Refer to Changing a Parameter in the User Mode under
Setup.

6. Verify that the temperature settings are at the desired value. Refer to Set
Up the Unity Controller under Setup as needed.

7. When the READY light turns on, place the controller purge switch in the
on position until the rest of the material in the flush syringe (used during
shut down) is dispensed.



Adhesive syringe latch
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Daily Startup and Operation  (contd)

8. Load an adhesive syringe in the applicator as follows:

a.. Open the adhesive syringe latch and remove the air cap.

b.. Remove the caps from both ends of the adhesive syringe and insert
the syringe into the applicator.

c.. Reinstall the air cap and close the latch.

9. Place the product on the moving plate and press the START button on
the robot to run products.
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Responding to Alarms 

Refer to Troubleshooting for a list of alarms and recommended corrective
actions.

Placing the System in Setback 

If the system will be operated again within the next 48 hours, place the
system in setback during nonoperational periods.

� To place the system in setback, change the Temperature Mode

parameter to SETBACK.

� To take the system out of setback, change the Temperature Mode

parameter to NORMAL.

Refer to Changing a Parameter in the User Mode under Setup as needed. If
the system will not be used in next 48 hours, it should be shut down. Refer to
Shutdown.

Monitoring the System 

Several parameters available on the controller are useful for system
monitoring, including, but not limited to, the following:

� OUTPUT PRESSURE

� TEMPERATURE/SETPOINT

� ELAPSED TIME

� PRODUCT COUNT

Refer to Set Up the Unity Controller under Setup for a description of all
controller parameters and the procedure for viewing or changing a
parameter.
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Shutdown 

Because PUR adhesive reacts with moisture in the air, exposure of the PUR
adhesive in the system to air must be minimized. The procedures below
represent the best practices for overnight or long‐term (longer than overnight)
shutdown.

Overnight Shutdown 
1. Shut down the system and allow the applicator to cool, leaving the

current syringe in the applicator. This will retain the seal and minimize the
exposure to air.

2. The next morning, follow the Daily Startup and Operation procedure
earlier in this section to install a new syringe.

Long‐Term Shutdown 
1. Place a large collection pan under the applicator.

WARNING! Risk of burns. When the last drops of adhesive are being
purged, the pressurized air will cause some adhesive spray. Ensure that the
collection pan is large enough to shield the operator from the spray.

2. Place the controller purge switch in the on position until all adhesive is
dispensed from the syringe, then place the switch in the off position.
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3. Open the applicator latch and, without putting pressure on the syringe,
remove the air cap.

4. Use a pick to remove any hardened adhesive from the syringe.

5. Install the air cap and close the latch

6. Remove the applicator nozzle and purge again to ensure that all
adhesive is dispensed.

CAUTION! Ensure that the flushing material is compatible with the PUR
adhesive being used. Refer to the MSDS for both the adhesive and the
flushing material.

7. Load a flush syringe into the applicator.

8. Purge again until a clean flow of flush material is achieved. Leave some
flush material in the syringe.

9. Reinstall the nozzle and purge the system again to flush all PUR
adhesive out of the nozzle. Leave some flush material in the syringe.

10. Turn off the air supply.

11. Turn off the controller.

12. Turn off the robot.
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Maintenance 
This section contains a recommended maintenance schedule and
procedures. Attempting any other maintenance procedures can result in
equipment damage, improper system operation, or personal injury.

Recommended Maintenance Schedule 

Table 7 provides recommended maintenance activities and a schedule for
performing those activities. Base how often you perform maintenance on
your operating conditions.

Table 7 Recommended Maintenance 

Component Activity Interval Procedure

Robot and
applicator

Inspect for
external damage

Daily When damaged parts pose a risk to
the operational safety of the unit
and/or safety of personnel, switch off
the system and have the damaged
parts replaced by qualified personnel.
Use only original Nordson spare parts.

Clean the exterior Daily Remove adhesive residue only with a
cleaning agent recommended by the
adhesive supplier. Heat with an air
heater if necessary.

Remove dust, flakes, etc. with a
vacuum cleaner or a soft cloth.

Do not damage or remove warning
labels. Replace any damaged or
removed warning labels.

Replace the air
supply desiccant
tube

When all material inside
the tube has turned pink

Relieve system pressure (refer to
System Pressure Relief in this section)
and replace the used desiccant tube,
ensuring that all fittings are secure.
Refer to Parts for the replacement
desiccant tube part number.

Unity controller Upgrade the
firmware

As needed Refer to Unity Controller Firmware
Upgrade in this section.
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System Pressure Relief 

System pressure must be relieved before you can safely proceed with many
troubleshooting and service‐related activities. Follow this procedure
whenever you need to relieve system pressure.

WARNING! Risk of burns. Failure to relieve system pressure can cause hot
material to spray from a connecting point. Relieve system pressure before
loosening or removing a hose, module, or any other part of a hot melt system.
Wear heat‐protective clothing, safety goggles (ANSI Z87.1 or equivalent),
and safety gloves.

1. Shut off the main air supply or set the air pressure regulator to zero (0).

2. Momentarily activate the purge switch on the controller.

3. When the service activity is completed, restore the system to normal
operation.
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Nozzle Cleaning 

Nozzles should be cleaned weekly or as needed to prevent clogging. You will
need the following items:

� Appropriate tools, including a torque wrench

� Cleaning supplies (refer to Table 8)

� Drain pans and disposable rags

1. To ease nozzle removal, ensure that the adhesive in the system is heated
at least to the softening point.

2. Stop the melter and applicator pumps.

3. Shut off the module‐actuating air.

4. Relieve system pressure. Refer to the melter manual as needed.

5. Remove the nozzle.

6. Clean the nozzle using one of the Nordson‐recommended methods
shown in Table 8. Use only cleaning agents recommended by the
adhesive supplier.

WARNING! Risk of explosion or fire. Follow the safety guidance and heating
recommendations on the Material Safety Data Sheets (MSDSs) for your
adhesives and nozzle‐cleaning solutions.

WARNING! Risk of explosion or fire. Use a controlled heating device, such
as a thermostatically controlled hot plate, to heat cleaning fluid, including
Nordson Type‐R fluid.

CAUTION! Risk of equipment damage. Do not use a wire brush (or a brush
with bristles harder than the nozzle) to clean nozzles.
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Table 8 Nozzle Cleaning Methods 

Cleaning Method Procedure

Electric heat gun/hot air
knife

NOTE:  This is the most
thorough method.

a. Heat the nozzles with a flameless electric heat gun or hot air knife.

b. Scrub the nozzles with a soft, non‐metallic brush to remove debris.

Ultrasonic tank a. Place the nozzles in an alkaline solution heated to the appropriate
temperature (refer to the MSDS) in an ultrasonic tank. Soak the nozzles for
approximately 10 minutes.

b. Scrub the nozzles with a soft, non‐metallic brush to remove debris.

c. Gently blow air through the nozzle orifices from the mounting side of the
nozzle.

Oven

NOTE:  This method will
cause discoloration of
unplated brass nozzles.
This discoloration is
cosmetic only and will
not adversely affect
nozzle performance.

NOTE:  This method is
not recommended for
color‐coded nozzles
(such as Saturn and CF
steel unibody nozzles)
because it will remove
the color from the
nozzles.

WARNING:  Risk of explosion, fire, or toxic vapor release.
Depending on the type of adhesive and/or organic solvent used
with the nozzles, heating them in an oven can cause a hazardous
event. Before using an oven to clean nozzles, consult with the
oven manufacturer about the viability of this method and the safety
risks. Follow the manufacturer's recommendations.

WARNING:  Use the oven heating controls to keep the oven at the
desired temperature. Do not use an oven that does not have
heating controls.

CAUTION: Risk of equipment damage. Remove O‐rings before
cleaning nozzles in an oven. Failure to do so can cause a chemical
reaction that will permanently damage the nozzles.

a. Ensuring that O‐rings have been removed from the nozzles, place them
in an electric oven heated to approximately 385 �C (725 �F). Allow the
nozzles to bake for approximately 3-4 hours.

WARNING:  The heating temperature and time may need to be
adjusted based on the oven type, the adhesive type, and the
amount of char buildup on the nozzles. Nordson Corporation
recommends testing this procedure on discarded nozzles prior to
using it on good nozzles.

WARNING:  Risk of fire. Use a heat‐proof cloth to clean nozzles. Even
cotton can burn in high‐temperature conditions.

WARNING:  Risk of equipment damage. Handle nozzles carefully to
avoid denting the orifices, which can degrade the adhesive pattern.

b. Turn off the oven and allow the nozzles to cool; then remove the
nozzles.

c. Wipe the nozzles with a soft cloth and then gently blow air through the
nozzle orifices from the mounting side of the nozzle.
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Nozzle Cleaning  (contd)

7. If there is any remaining char buildup on the nozzles, gently scrape the
char from the nozzle.

8. Reinstall the nozzles.

9. Restore the system to normal operation.

Applicator Cleaning 

The applicator adhesive passages should be cleaned as needed to prevent
clogging. You will need the following items:

� Appropriate tools, including a torque wrench

� Flush syringe

� Heater lubricant

� High‐temperature grease

� Drain pans, disposable shop rags, and cotton swabs

NOTE:  Visit http://www.youtube.com/user/NordsonAdhesiveSyst/videos to
view a video of the applicator cleaning procedure.

Prepare for Applicator Cleaning 

1. To ease component removal, ensure that the adhesive in the system is
heated at least to the softening point.

2. Stop the melter and applicator pumps.

3. Relieve system pressure. Refer to the melter manual as needed.

4. Place a large drain pan under the applicator.

WARNING! Risk of burns. When the last drops of adhesive are being
purged, the pressurized air will cause some adhesive spray. Ensure that the
collection pan is large enough to shield the operator from the spray.

5. Place the controller purge switch in the on position until all adhesive is
dispensed from the syringe, then place the switch in the off position.
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6. Open the applicator latch and, without putting pressure on the syringe,
remove the air cap.

7. Use a pick to remove any hardened adhesive from the syringe.

8. Install the air cap and close the latch

9. Remove the applicator nozzle and purge again to ensure that all
adhesive is dispensed.

CAUTION! Ensure that the flushing material is compatible with the PUR
adhesive being used. Refer to the MSDS for both the adhesive and the
flushing material.

10. Load a flush syringe into the applicator.

11. Purge again until a clean flow of flush material is achieved (at least one
minute).

12. Remove the flush syringe.

13. Shut off the module‐actuating air.

14. Engage the purge switch one last time to remove any remaining system
pressure.

15. Disconnect the air supply and cable connections from the applicator
solenoid valve.
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Remove the Module 
1. If you have not already done so, remove the nozzle from the module and

clean it. Refer to Nozzle Cleaning.

See Figure 21.

2. Loosen the screws that secure the front plate (3) and remove the
module�(2) from the applicator.

3. Remove the pins that secure the solenoid assembly (1) to the module
and then separate the solenoid assembly from the module.

3

2

1

Figure 21 Removing the module

1. Solenoid assembly

2. Module

3. Front plate
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Disassemble and Clean the Module 

See Figure 22.

1. Remove the air cap (1) and its attached O‐ring(s). Use shop rags or
towels to wipe the air cap clean of any adhesive residue.

2. Holding the module body (2), push the piston assembly components (4)
and seal pack (5) out through the bottom of the module.

3. Use a clean shop rag to wipe the interior and exterior of the module clear
of any adhesive residue.

4. Clean the exterior of the seal pack with shop rags and cotton swabs and
wipe the piston clean of any adhesive.

5. Clear any adhesive residue from the module’s adhesive feed hole (3).
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Figure 22 Module disassembly (left‐side image: fixed module; right‐side image:
adjustable module)

1. Air cap

2. Module body

3. Adhesive feed hole

4. Piston assembly components

5. Seal pack

6. Nozzle cap
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Clean the Applicator Manifold 
1. Turn off the controller and disconnect the heater cable from the controller

or heater block.

See Figure 23.

2. Remove the screws that secure the heater block (2) to the manifold and
remove the heater block.

3. Clear the heater block adhesive feed passage of any residue. Use a shop
rag to wipe off the heater block.

4. Gently remove the seal insert (1) from the manifold and wipe the seal
clean with a rag or towel.

5. Insert a clean shop rag or cloth into the top of the manifold to clean the
interior chamber and accessible surfaces.

6. Reinstall the seal insert (1) in the bottom of the manifold.

7. Dip the heater block screws into a lubricant and reinstall the heater
block�(2) on the manifold.

1

2

Figure 23 Heater block components and location of adhesive passages

1. Heater block and O‐ring 2. Seal insert
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Reassemble the Module 

See Figure 24.

1. Insert the piston (2) into the seal pack (4) and use a syringe and small
needle to fill the seal pack with high‐temperature grease just until the
grease starts coming out the hole on the opposite side of the seal pack.
Wipe off the excess grease.

2. Remove the piston from the seal pack.

3. Push the seal pack (4) into the bottom of the module body (3) until it stops
against the bottom of the piston bore.

4. Ensure that the nozzle cap O-ring (5) is attached to the nozzle cap (6)
and reinstall the nozzle cap.

5. Insert the piston into the seal pack through the top of the module, being
careful to keep the piston at a 90‐degree angle with the seal pack, and
screw the air cap (1) onto the module.
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Figure 24 Module assembly (left‐side image: fixed module; right‐side image:
adjustable module)

1. Air cap

2. Piston

3. Module body

4. Seal pack

5. Nozzle cap O‐ring

6. Nozzle cap
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Reinstall the Solenoid and Module 

See Figure 25.

1. Reinstall the solenoid assembly (1) on the module, ensuring that the pins
are fully inserted for a secure connection between the module and
solenoid.

2. Position the module (2) on the the heater block dowel pin (4) and secure
the front plate (3) to the heater block, tightening the screws evenly.

3

2

1

4

Figure 25 Reassembling the applicator

1. Solenoid assembly

2. Module

3. Front plate

4. Heater block dowel pin

3. Reconnect the air supply and cable connections to the applicator
solenoid valve.

4. Load an adhesive syringe in the applicator as follows:

a.. Open the adhesive syringe latch and remove the air cap.

b.. Remove the caps from both ends of the adhesive syringe and insert
the syringe into the applicator.

c.. Reinstall the air cap and close the latch.

5. Restore the system to normal operation.
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Unity Controller Firmware Upgrade 

Visit www.enordson/support to download firmware updates, software utilities,
and applicable instructions.

NOTE:  The Unity controller displays the current software version at startup.
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Troubleshooting 
Troubleshooting begins when the flow of adhesive from the applicator stops
or diminishes unexpectedly or when a control system alerts you of a problem
through an alarm or visual display. This section covers only the most
common problems you may encounter. If you cannot solve a problem with
the information given here, contact your local Nordson representative for
help.

For additional troubleshooting information, refer to the manuals provided with
the other equipment used in the hot melt system.

Unity Controller Alarm Troubleshooting 

Refer to this table to troubleshoot the alarms generated by the controller.
Refer to the next table for general troubleshooting.

Alarm Cause Corrective Action

NO ALARMS OR
MESSAGES

No None.

WARNING! ADHESIVE MAY
BE CURED.

Timer has passed 16 hours. Check the adhesive quality and
replace the adhesive syringe as
needed. Refer to Daily Startup and
Operation as needed. Reset the
timer. Refer to Set Up the Unity
Controller under Setup as needed.

TIMER PAUSED! Timer has been paused Restart the timer. Refer to Set Up
the Unity Controller under Setup as
needed.

SHORTED RTD FAULT! Applicator sensor shorted Replace the sensor.

OPEN RTD FAULT! Applicator sensor open Replace the sensor.

TEMPERATURE TOO HIGH! Heater temperature is more than
‐12��C (10 �F) above the
temperature setpoint

Allow time for the system to adjust
to the temperature setpoint. Correct
the problem causing the excessive
heat. Refer to Set Up the Unity
Controller under Setup as needed.
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General Troubleshooting 

Refer to this table for general system troubleshooting. For troubleshooting
based on the alarms generated by the Unity controller, refer to the previous
table, Unity Controller Alarm Troubleshooting

Problem Possible Cause Corrective Action

1. Applicator does not
heat

System power not on Verify that the system power is turned on.

Loose electrical connection Verify that all electrical connections (cordsets
and cables) at the controller and the applicator
are secure.

Broken or missing electrical pins Check for broken or missing pins at all electrical
connections. Repair or replace damaged
components.

Applicator temperature setpoint
too low

Increase the temperature setpoint. Do not
exceed 116 �C (240 �F). Refer to Set Up the
Unity Controller under Setup as needed.

Incorrect configuration switch
settings

Ensure that the configuration switches on the
Unity controller board are set as shown in
Figure�41 under Technical Data.

2. Applicator
underheats or
overheats

System in setback (standby)
mode

Take the system out of the setback mode.

Applicator temperature setpoints
too low or too high

Increase or decrease the temperature setpoint.
Do not exceed 116 �C (240 �F). Refer to Set Up
the Unity Controller under Setup as needed.

Failed heater or sensor Check the applicator heater or sensor. Refer to
Checking the Applicator Heater or Checking the
Applicator Sensor later in this section.

Incorrect configuration switch
settings

Ensure that the configuration switches on the
Unity controller board are set as shown in
Figure�41 under Technical Data.

Continued...
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Problem Possible Cause Corrective Action

3. Erratic bead width
(from part to part)

Nozzle size incorrect Change the nozzle size to the appropriate
diameter for the bead width.

Applicator temperature setpoint
too low

Increase the temperature setpoint. Do not
exceed 116 �C (240 �F). Refer to Set Up the
Unity Controller under Setup as needed.

Old PUR adhesive in system Clean or replace the nozzle, clean the adhesive
passages (see Figure 26), and/or replace the
module. Refer to Nozzle Cleaning and/or
Applicator Cleaning under Maintenance.

Adhesive leaking under the
syringe flange

Check the syringe seal and clean the interface
as needed.

Top of adhesive syringe plugged Remove the cured layer of adhesive from the top
of the adhesive syringe.

4. Bead too small Low input air supply Ensure that the input air pressure is greater than
3.4 bar (50 psi).

Old PUR adhesive in system Clean or replace the nozzle, clean the adhesive
passages (see Figure 26), and/or replace the
module. Refer to Nozzle Cleaning and/or
Applicator Cleaning under Maintenance.

Applicator temperature setpoint
too low

Increase the temperature setpoint. Do not
exceed 116 �C (240 �F). Refer to Set Up the
Unity Controller under Setup as needed.

Damaged parts Clean, inspect, and replace parts as needed.

Continued...

Figure 26 Location of adhesive passages
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General Troubleshooting  (contd)

Problem Possible Cause Corrective Action

5. Bead width changes
on the part

Robot speed inconsistent Check the program speed settings. Refer to the
robot documentation.

Applicator position too high/low Check the program height settings and/or check
the height of the product. Refer to the robot
documentation.

6. No adhesive output Low or no input air supply Ensure that the input air pressure is greater than
3.4 bar (50 psi).

No signal from robot Test the signal using the robot purge switch. If
the applicator purges, the problem is in the
robot. Refer to the robot documentation to
troubleshoot the robot. If the applicator does not
purge, check the setup. Refer to Installation as
needed.

Solenoid connection lost Check the red light on the solenoid valve. If the
red light is not illuminated, replace the solenoid.

Old PUR adhesive in system Clean or replace the nozzle, clean the adhesive
passages (see Figure 26), and/or replace the
module. Refer to Nozzle Cleaning and/or
Applicator Cleaning under Maintenance.

Cured material inside of
applicator

Clean or replace the nozzle, clean the adhesive
passages (see Figure 26), and/or replace the
module. Refer to Nozzle Cleaning and/or
Applicator Cleaning under Maintenance.

Applicator temperature setpoint
too low

Increase the temperature setpoint. Do not
exceed 116 �C (240 �F). Refer to Set Up the
Unity Controller under Setup as needed.

Module needle stroke too short Increase the needle stroke to 2 mm (4 turns).
Refer to the needle stroke adjustment steps in
Set Up the Unity PURJet 30 Applicator under
Setup as needed.

7. Leaks at bleed hole
on module

Adhesive seal failure Replace the module.

8. Controller does not
power on

Open fuse Replace the open fuse. Refer to Parts for fuse
part numbers.

Continued...
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Corrective ActionPossible CauseProblem

9. Air leakage through
the exhaust when the
valve is idle

Piston shifted (pinched by
housing)

Test the piston seal as follows:

1 See Figure 27. Connect a pressure gauge to
the lower exhaust on the solenoid valve.

2 Close (de‐energize) the solenoid valve and
observe the pressure change.

The pressure change should be less than
0.14 MPa/min (20 psig/min) at a gauge
fixture volume of 13 mL (0.8 in.3) to 16 mL
(1.0 in.3).

Replace the blue piston seal as needed. Refer
to the instruction sheet provided in the seal pack
service kit. Refer to Parts for the service kit part
number.

10. Dots jetting in
random directions

Applicator temperature setpoint
too low

Increase the temperature setpoint. Do not
exceed 116 �C (240 �F). Refer to Set Up the
Unity Controller under Setup as needed.

Nozzle obstructed Clean the nozzle. Refer to Nozzle Cleaning
under Maintenance.

11. Adhesive building up
on nozzle

Applicator temperature setpoint
too low

Increase the temperature setpoint. Do not
exceed 116 �C (240 �F). Refer to Set Up the
Unity Controller under Setup as needed.

Nozzle obstructed Clean the nozzle. Refer to Nozzle Cleaning
under Maintenance.

Module needle stroke too short Increase the needle stroke to 2 mm (4 turns).
Refer to the needle stroke adjustment steps in
Set Up the Unity PURJet 30 Applicator under
Setup as needed.

Figure 27 Location of solenoid valve air port used for piston seal test procedure
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Checking the Applicator Heater 

NOTE:  Cordsets for applicators with a platinum sensor are
customer‐supplied. Refer to other documentation as needed.

1. Disconnect and lock out electrical power to the system.

2. Disconnect the applicator cordset.

3. See Figure 28 for nickel‐sensor cordsets. Use an ohmmeter to check the
heater resistance and continuity at the heater pins on the cordset:

� If you measure low resistance, the heaters are operating normally.

Return to the procedure that referenced this check.

� If you measure high resistance or if an open circuit is indicated, there

may be a broken wire, a loose connection, or a defective heater.
Continue to the next step.

RTD

HEATER

GROUND

RTD

HEATER

Figure 28 Pin positions on a nickel applicator cordset

4. Remove the appropriate cordset connector hood and inspect the heater
wiring. Make sure there are no broken wires or loose connections and
that the heaters are wired correctly.

� If any wiring problems are found, correct the problems and restore the

system to normal operation.

� If no wiring problems are found, the heater is probably defective.

Replace the heater.
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Checking the Applicator Sensor 

NOTE:  Cordsets for applicators with a platinum sensor are
customer‐supplied. Refer to other documentation as needed.

NOTE:  You will need to know the temperature of the sensor to properly
perform this check.

1. Disconnect and lock out electrical power to the system.

2. Disconnect the applicator cordset.

3. See Figure 28 for nickel‐sensor cordsets. With the sensor at a known
temperature, use an ohmmeter to measure the sensor resistance at the
sensor pins on the cordset.

4. See Figure 29 (for nickel sensors) or Figure 30 (for platinum sensors) to
determine the correct resistance of the sensor based on its temperature:

� If the measured resistance is correct, the sensor is operating

properly. Return to the procedure that referenced this check.

� If the measured resistance indicates an open circuit, continue to the

next step.

5. Remove the appropriate cordset connector hood and check for loose
sensor wires or wire connections. Tighten any loose connections.

6. Check the sensor resistance again. If the resistance is normal, the sensor
is now operating properly. If it is not, continue to the next step.

7. Disconnect the sensor wires, measure the resistance across them, and
compare the results to Figure 29:

� If the measured resistance is within the appropriate range, reconnect

the sensor wires, reinstall the cordset connector hood, and return to
the procedure that referenced this check.

� If the measured resistance is not within the appropriate range, replace

the sensor.
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Checking the Applicator Sensor  (contd)
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Figure 29 Nickel sensor resistance vs. sensor temperature
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Figure 30 Platinum sensor resistance vs. sensor temperature

Note: Cordsets for applicators with a platinum sensor are customer supplied. Refer
to other equipment documentation as needed.



Unity PURJet 30 Dispensing System68

Part 1104545_06 � 12/2013 Nordson Corporation

This page intentionally left blank.



Unity PURJet 30 Dispensing System 69

Part 1104545_06� 12/2013 Nordson Corporation

Parts 
To order parts, call the Nordson Customer Service Center or your local
Nordson representative. Use these five‐column parts lists, and the
accompanying illustrations, to describe and locate parts correctly. The
following chart provides guidance for reading the parts lists.

The number in the Item column corresponds to the circled item number
in the parts list illustration. A dash in this column indicates that the item is
an assembly.

The number in the Part column is the Nordson part number
you can use to order the part. A series of dashes indicates
that the part is not saleable. In this case, you must order
either the assembly in which the part is used or a service kit
that includes the part.

The Description column describes the part and
sometimes includes dimensions or specifications.

The Note column contains letters that refer to notes at
the bottom of the parts list. These notes provide
important information about the part.

The Quantity column tells you how many of the part
is used to manufacture the assembly shown in the
parts list illustration. A dash or AR in this column
indicates that the amount of the item required in
the assembly is not quantifiable.

Item Part Description Quantity Note

— 0000000 Assembly A —

1 000000 � Part of assembly A 2 A

2 ‐ ‐ ‐ ‐ ‐ ‐ � � Part of item 1 1

3 0000000 � � � Part of item 2 AR

NS 000000 � � � � Part of item 3 2

NOTE A: Important information about item 1

AR: As Required

NS: Not Shown



Unity PURJet 30 Dispensing System70

Part 1104545_06 � 12/2013 Nordson Corporation

Unity PURJet 30 Dispensing System Assemblies 

See Figure 31.

NOTE:  Refer to Cable Part Numbers later in this section for a list of all
cables that may be used with the Unity PURJet 30 system.

Item Part Description Quantity Note

1 1099056 APPLICATOR, UNITY, PURJET 30, Ni120 1 A

1107462 APPLICATOR, UNITY, PURJET 30, PT100 1 A

2 1107104 � KIT,REG,SEP,FILTER,COMBO,AIR KIT,
PURJET30

B

3 1120213 MODULE,JET,ADJUSTABLE,PJ30 7MIL — C

1104347 MODULE,JET,PURJET30,FIXED — C

4 1120887 ENCLOSURE ASSY,UNITY 1

5 1094180 ROBOT,JR2303N, 300MM X 320MM X 100MM 1 D

NS 1010791 ROBOT, JR2403, 400MM X 400MM X 150MM 1 D

NS 1120888 KIT, SHIP WITH, PJ30 1 E

NOTE A: Refer to Unity PURJet 30 Applicator Parts later in this section.

B: Refer to Air Kit Parts later in this section.

C: Refer to Jet Module Parts later in this section.

D: Refer to the robot product manual for parts information.

E: Refer to Contents of the Ship‐With Kit under Installation for an illustration and parts list.

NS: Not Shown
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4

1

2

5

3

Figure 31 Unity PURJet 30 dispensing system assemblies
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Unity PURJet 30 Applicator Parts 

See Figure 32.

Item Part Description Quantity Note

— 1099056 APPLICATOR, UNITY, PURJET 30, Ni120 — A

— 1107462 APPLICATOR, UNITY, PURJET 30, PT100 — A

01 1104308 � MANIFOLD,30CC SYRINGE,PJ30 1

02 1104309 � BLOCK,HEATER,PJ30 1

03 940191 � O RING,VITON,  .813X .938X.063 1

04 815950 � SCR,SKT,M5X30,ZN 2

05 1104310 � PLATE,FRONT,HEATER BLOCK,PJ30 1

06 982166 � SCR,SKT,M5X16,BL 2

07 1104311 � INSERT,SEAL,30CC SYRINGE,PJ30 1

08 940211 � O RING,VITON,  .938X1.063X.063-021 1

10 1038151 � SCR,SKT,M6X30,SSTL 2

11 1086856 � STANDOFF, SWING LATCH,3M SYRINGE 2

12
1050984 � CORDSET,UA,T-STYLE,NI120,240V,200W

(120‐ohm nickel applicators)
1 B

1050987 � CORDSET,UA,M‐STYLE,PT100,240V,200W,
SQR (100‐ohm platinum applicators)

1 C

13 1086857 � LATCH,SWING,3M SYRINGE 1

14 1086859 � SETSCRM,M4 X 9,BALL,SPRING
PLUNGER,STL

1

15 1086896 � INSULATOR,MANIFOLD/BRACKET,3M
SYRINGE

1

16 1097793 � BRACKET, GUN MOUNT, JR2403 1

17 184799 � INFORMATION PLATE 1

18 181862 � PLATE,CF,WARNING,CE,HOT 2

19 290083 � SIGN,DANGEROUS VOLTAGE 2

20 1094222 � CAP,AIR,3M 30CC SYRINGE 1

21 7103784 � PLUG-TYPE THREAD-IN FTG.
-G-D06-G1/8-0000

1

22 941161 � O RING,VITON,  .750X .938X.094, -116 1

23 985267 � PIN,DOWEL,.250X1.000,H&G 2

24 142278 � ADAPTER,BAYONET,1/8NPT,1.0-IN 1

25 1086870 � CAPSCRM,SOC HD/FLANGED,M5X10,STL,
BLK

2

28 1104316 � INSULATOR,G1/8,15MM,JETTING,VALVE 1

29 1121957 � CONN,MALE,6MM T X 1/8 UNI 2

30 982611 � SCR,SKT,M3.0.5X18,ZN 2

31 1120858 � FITTING,TUBE,STEM,G1/8 TO 6MM 2

32 ‐ ‐ ‐ ‐ ‐ ‐ � SOLENOID,SATURN PLAT,BARE,4WAY,
24VDC

1 D

33 981905 � SCR,DRIVE,RD,2X .187,ZN 10

34 1121958 � CONN,MALE,ELBOW,8MM T X 1/8UNI 3

35 331450 � PIN,DOWEL,M4X10MM,H&G 1

37 1005078 � TUBING,PFA,6MM ODX 1 MM WALL 3 ft

38 1108369 � SEALANT,PASTE, NSF-H1,FOOD GRADE 1

39 1108371 � LUBRICANT,NEVER-SEEZ,NSF-H1,FOOD
GRADE

1

Continued...
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NoteQuantityDescriptionPartItem

40 900298 � COMPOUND,HEAT SINK,5 OZ TUBE,11281 1

41 1108372 � LUBRICANT,O-RING,NSF-H1,FOOD GRADE,
4L

1

44 971790 � UNION,STRAIGHT,6MM T 1

46 900470 � ADHESIVE,LOCTITE 272,RED,HI TEMP,50ML 1

NS 1107104 � KIT,REG,SEP,FILTER,COMBO,AIR KIT,PJ30 1 E

NS 1121330 � CABLE, SOLENOID,M8,3-WIRE,5METERS 1 F

NOTE A: Modules are sold separately. Refer to Jet Module Parts later in this section.

B: To replace this cordset, order service kit part 1108616.

C: To replace this cordset, order service kit part 1108617.

D: To replace this solenoid, order service kit part 1121358.

E: Refer to Air Kit Parts later in this section.

F: This cable is used to connect the applicator solenoid valve to the controller.

NS: Not Shown
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Unity PURJet 30 Applicator Parts  (contd)
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NOTES:
1) APPLY THREAD LUBRICANT (ITEM 39) TO ALL STRIGHT THREADS
2) APPLY THREAD SEALANT (ITEM 38) TO SILENCER (ITEM 27)
3) APPLY HEATER LUBE (ITEM 42) TO HEATERS
4) APPLY HEAT SINK (ITEM 40) TO SENSOR
5) APPLY ORING LUBE(ITEM 41) TO ALL ORINGS

Figure 32 Unity PURJet 30 applicator parts
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Air Kit Parts 

See Figure 33.

Item Part Description Quantity Note

— 1107104 KIT,REG,SEP,FILTER,COMBO,AIR KIT,
PURJET30

—

01 1107101 � ACCUMULATOR,MUFFLER,PJ30 1

02 971105 � CONN,MALE,12MM  X 3/8UNI 1

03 971102 � CONN,MALE,10MM T X 3/8UNI 2

04 1107125 � CONN,MALE,RUN TEE,12MM T X 3/8UNI 1

05 1107126 � REDUCER,12MM STEM X 6MM T 1

06 1107102 � FILTER REG,3/8 PORTS,W/GAUGE 1

07 1107127 � FILTER,WATER SEPARATOR,3/8NPT,
MODULAR

1

08 1107103 � BRACKET,CAST,REGULATOR,Y30T 1

09 1082141 � MUFFLER,R1/2,40 dB 1

10 1107100 � BRACKET,L-SHAPE,AIR KIT,PJ30 1

11 1064886 � SCR,SKT,M6x14,ZN 2

12 1051220 � SCR,SKT,1/2-13X1.000,BL 2

NS 1107130 � TUBING,SOFT NYLON,12MMX1.5MM,BLUE 3 m A

NS 1107128 � ADAPTER,8MM OD TUBE TO 9MM ID
BARBED

1 A

NS 1107131 � TUBING,SOFT NYLON,10MMX1.25MM,BLUE 6 m A

NS 1107129 � ADAPTER,8MM OD TUBE TO 7.5MM ID
BARBED

2 A

NS 1094186 � DRYER,AIR,DESICCANT,INLINE,1/4NPT 1 A

NS 971100 � CONN,MALE,6MM T X 1/4UNI 2 A

NS 973500 � COUPLING,PIPE,HYD,1/4,STL,ZN 1 A

NOTE A: These items are shipped with the air kit and installed when the air supply connections are made.

NS: Not Shown
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Jet Module Parts 

One of two module types may be present on the applicator: fixed or
adjustable. Refer to the correct parts list for your applicator.

Fixed Module 

See Figure 34.

Item Part Description Quantity Note

— 1104347 MODULE,JET,PURJET30,FIXED —

1 1106972 � MODULE BODY,PURJET30 1

2 1106951 � AIR CAP,FIXED,1.5MM,PURJET30 1

3 940111 � O RING,VITON,.301ID X .070W,BR, 10411 SB 2

4 940090 � O RING,VITON,.208ID X .070W,BR,10409 1

5 1104314 � SEAL,PISTON,0.75OD,TURCON,113 1 A

6 941123 � O RING,VITON, .500X .688X.094 1 A

7 1104313 � NEEDLE,PISTON,SINGLE PART,PURJET30 1 A

8 1104348 � SEAL PACK,PURJET30 1 A

9 940191 � O RING,VITON, .813X .938X.063 1

10 ‐ ‐ ‐ ‐ ‐ ‐ � NOZZLE,0.008IN DIA,SST,PURJET30 1 B

11 1101669 � SCREW,SHCS M4X10,GD12.9,ZN 2

12 940172 � O RING,VITON,.676ID X .070W,BR 1

13 983401 � WASHER,LK,M,SPT,M5,STL,ZN 2

14 815945 � SCR,SKT,M5X20,ZN 2

15 — � Item no. not used —

16 — � Item no. not used —

17 1108371 � LUBRICANT, NEVER-SEEZ, NSF-H1,FOOD
GRADE

1

18 1108372 � LUBRICANT,O-RING,NSF-H1,FOOD GRADE,
4L

1

19 783959 � HIGH‐TEMP. GREASE GLS 595/N2 TUBE:
250G

1

NOTE A: This item is available in a service kit that includes replacement instructions. Refer to Service Kit Parts later
in this section.

B: For a replacement 0.008‐in. nozzle, order service kit part 1120499. An optional  0.007‐in. nozzle size is
also available. For a 0.007‐in. nozzle, order service kit part 1120498.
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Adjustable Module 

See Figure 35.

Item Part Description Quantity Note

— 1120213 MODULE,JET,ADJUSTABLE,PJ30 7MIL —

1 1106972 � MODULE BODY,PURJET30 1

2 1120404 � AIR CAP,ADJUSTABLE,PURJET30 1

3 940111 � O RING,VITON,.301ID X .070W,BR, 10411 SB 2

4 940090 � O RING,VITON,.208ID X .070W,BR,10409 1

5 1104314 � SEAL,PISTON,0.75OD,TURCON,113 1 A

6 941123 � O RING,VITON, .500X .688X.094 1 A

7 1104313 � NEEDLE,PISTON,SINGLE PART,PURJET30 1 A

8 1104348 � SEAL PACK,PURJET30 1 A

9 940191 � O RING,VITON, .813X .938X.063 1

10 ‐ ‐ ‐ ‐ ‐ � NOZZLE,0.008IN DIA,SST,PURJET30 1 B

11 1101669 � SCREW,SHCS M4X10,GD12.9,ZN 2

12 940172 � O RING,VITON,.676ID X .070W,BR 1

13 983401 � WASHER,LK,M,SPT,M5,STL,ZN 2

14 815945 � SCR,SKT,M5X20,ZN 2

15 1106950 � PIN,ADJUSTMENT,STROKE,PURJET30 1

16 940081 � O RING,VITON, .188X.313X.063, 10408 1

17 1108371 � LUBRICANT, NEVER-SEEZ, NSF-H1,FOOD
GRADE

1

18 1108372 � LUBRICANT,O-RING,NSF-H1,FOOD GRADE,
4L

1

19 783959 � HIGH‐TEMP. GREASE GLS 595/N2
TUBE:250G

1

NOTE A: This item is available in a service kit that includes replacement instructions. Refer to Service Kit Parts later
in this section.

B: For a replacement 0.008‐in. nozzle, order service kit part 1120499. An optional  0.007‐in. nozzle size is
also available. For a 0.007‐in. nozzle, order service kit part 1120498.
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Cable Part Numbers 

The cables shown below are for use only in systems using 120‐ohm nickel
sensors. Cables for systems using 100‐ohm platinum sensors are
customer‐supplied.

Part Description Note

1075062 CABLASSY,3COND,18AWG,IEC,PWR,NO PLUG (Unity controller power cable)

1121438 CABLE ASSY,SHIELDED,37,D SHELL (robot‐to‐controller cable)

1023676 CABLE,PWR,3‐COND,IEC,9FT10‐IN,BR/BLU/G‐Y (robot power cable)

1121330 CABLE, SOLENOID,M8,3-WIRE,5METERS (PJ30 applicator solenoid)

164045 CBL,ADPTR, 12P/6S, 10FT, T-STYLE A

1121906 CABLE ASSY,SERIAL MALE TO USB,6FT,UNITY (robot‐to‐PC cable)

NOTE A: This extension cable may be used to connect an applicator cordset to the controller. The following
additional lengths are available: 117123 (6 ft), 108946 (16 ft), 135972 (24 ft), 753462 (30 ft).

Optional Accessories 

Part Description Note

1010793 Teaching pendant, robot

1108193 Preheater, adhesive cartridge
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Service Kit Parts 

Module Seal Pack Replacement Kit 

See Figure 36.

Item Part Description Quantity Note

— 1108614 KIT,SERVICE,MODULE,SEAL PACK REPL. —

— 1104348 � SEAL PACK,PJ30 1 A

1 1104320 � � HOUSING,SEAL PACK,ULTEM,PURJET30 1

2 1071968 � � SEAL, SPRING, .100 X .442 X .130 2

3 983012 � � DISC,SEAL SUPPORT 2

4 986502 � � RETAINING RING,INT, 43,PUSHON 2

5 940172 � � O RING,VITON,.676ID X .070W,BR 1

6 940181 � � O RING,VITON,.739ID X .070W,BR,10418 1

NS 1108372 � � LUBRICANT,O-RING,NSF-H1,FOOD
GRADE, 4L

1

NS 1120252 � GREASE, HIGH TEMP, PTFE, NSF 1

NS 1120021 � INSTRUCTIONS,PISTON REPL.,SEAL PACK
REPL.

1 B

— 1108618 KIT,SPARES,SEAL,MULTIPACK — A

2 1071968 � SEAL, SPRING, .100 X .442 X .130 10

3 983012 � DISC,SEAL SUPPORT 10

4 986502 � RETAINING RING,INT, 43,PUSHON 10

5 940172 � O RING,VITON,.676ID X .070W,BR 5

6 940181 � O RING,VITON,.739ID X .070W,BR,10418 5

NS 1120201 � LUBRICANT,O-RING,NSF-H1,10 ML TUBE 1

NS 1120021 � INSTRUCTIONS,PISTON REPL., SEAL PACK
REPL.

1 B

NOTE A: Refer to Applicator Component Expected Life under Technical Data for the expected life of these
components.

B: Refer to http://emanuals.nordson.com/ for instruction sheets.

NS: Not Shown

Module Piston Replacement Kit 

See Figure 36.

Item Part Description Quantity Note

— 1108615 KIT,SERVICE,PISTON REPL. PJ30 —

7 1104314 � SEAL,PISTON,0.75OD,TURCON,113 1

8 941123 � O RING,VITON, .500X .688X.094 1

9 1104313 � NEEDLE,PISTON,SINGLE PART,PJ30 1 A

NS 1120201 � LUBRICANT,O-RING,NSF-H1,10 ML TUBE 1

NS 1120021 � INSTRUCTIONS,PISTON REPL.,SEAL PACK
REPL.

1 B

NOTE A: Refer to Applicator Component Expected Life under Technical Data for the expected life of these
components.

B: Refer to http://emanuals.nordson.com/ for instruction sheets.

NS: Not Shown
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Recommended Spare Parts and Supplies 

Equipment Parts Item Note

Unity controller 1122069 KIT, CONTROLLER,UNITY (includes circuit boards and
control panel)

320613 FUSE, 250V, 5A, PC‐MOUNT (3 required)

939306 FUSE, 5X20, 250V, 3.15A (2 required)

1041036 STDBTRY,LITH,COIN,3.0V,225MA (battery)

PURJet 30 applicator 1050984 CORDSET,UA,T‐STYLE,NI120,240V,200W

1050987 CORDSET,UA,M‐STYLE,PT100,240V,200W, SQ

1121358 KIT,SOLENOID,PURJET, REPLACEMENT A

1121330 CABLE, SOLENOID,M8,3-WIRE,5METERS

940191 O RING,VITON, .813X .938X.063

940211 O RING,VITON, .938X1.063X.063

941161 O RING,VITON, .750X .938X.094, ‐116

940111 O RING,VITON,.301ID X .070W,BR, 10411 SB

1108369 SEALANT, PASTE, NSF-H1, FOOD GRADE

1108371 LUBRICANT, NEVER-SEEZ, NSF-H1,FOOD GRADE

900298 COMPOUND,HEAT SINK,5 OZ TUBE,11281

1120201 LUBRICANT, O-RING, NSF-H1, 10 ML TUBE

Air kit 1082141 MUFFLER,R1/2,40 dB

1094186 DRYER,AIR,DESICCANT,INLINE,1/4NPT

Jet module 1104347 MODULE,JET,PURJET30,FIXED B

1120213 MODULE,JET,ADJUSTABLE,PJ30 7MIL B

1108614 KIT, SERVICE, MODULE, SEAL PACK REPL. A, C

1108615 KIT, SERVICE, PISTON REPL. NC30 A, C

1120499 KIT, NOZZLE, .008 DIA, SST, PURJET30 (standard) A, B

1120498 KIT, NOZZLE, .007 DIA, SST, PURJET30 (optional) A, B

1104314 SEAL,PISTON,0.75OD,TURCON,113 A

940111 O RING,VITON,.301ID X .070W,BR, 10411 SB

940090 O RING,VITON,.208ID X .070W,BR,10409

941123 O RING,VITON, .500X .688X.094

940191 O RING,VITON, .813X .938X.063

940081 O RING,VITON, .188X.313X.063, 10408

1106950 PIN,ADJUSTMENT,STROKE,NC30 A

Supplies 1108369 SEALANT, PASTE, NSF-H1, FOOD GRADE

1108371 LUBRICANT, NEVER-SEEZ, NSF-H1,FOOD GRADE

900298 COMPOUND,HEAT SINK,5 OZ TUBE,11281

1120201 LUBRICANT, O-RING, NSF-H1, 10 ML TUBE

783959 HIGH‐TEMP. GREASE GLS 595/N2 TUBE:250G

NOTE A: Refer to Applicator Component Expected Life under Technical Data for the expected life of these
components.

B: As applicable for your system.

C: Refer to Service Kit Parts earlier in this section for the parts included in this kit.
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Technical Data 

Unity PURJet 30 Dispensing System Specifications 

Component Item Specification

System Transport temperature ‐45-75 �C (‐49-167 �F)

Storage temperature ‐45-75 �C (‐49-167 �F)

Ambient temperature 0-50 �C (32-122 �F)

Humidity 10-95% non‐condensing

Unity robot Weight 35 kg (77 lb)

Dimensions (l x w x h) 560 mm (W) x 529 mm( D) x 649 mm (H)

Unity controller Operating air pressure 4-8 bar (60-120psi)

Weight 7.2 kg (15.9 lb)

Dimensions (l x w x h) 264 mm (W) x 152 mm (D) x 264 mm (H)

Unity PURJet 30
applicator

Weight 1.6 kg (3.4 lb)

Material compatibility Rated for use with all commercially available
pressure sensitive and EVA hot melt
adhesives and polyurethane reactive (PUR)
adhesives, excluding any compound that
contains polyamides

Adhesive viscosity Varies depending on nozzle size and flow rate

Solenoid valve air flow 15 scfm minimum

Electrical Specifications 

Component Item Specification

Unity robot Supply voltage 180-250 VAC, 1‐phase, 50/60 Hz, 200 W

Unity controller Supply voltage 200-240 VAC, 1‐phase, 50/60 Hz, 290�W

Heating zones One (applicator), 1200 W maximum

Control temperature range Ambient to 120 �C (ambient to 250 �F)

Control temperature stability 0.5 �C (1 �F)

Unity PURJet 30
applicator

Supply voltage 200-240 VAC, 1‐phase, 50/60 Hz, 250 W
(supplied from controller)

Sensor type 120‐ohm nickel

or

100‐ohm platinum
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Applicator Component Expected Life 

Applicator Component
Expected Life

(number of cycles)

Solenoid valve (see Note) 50 million

Stroke adjustment pin (adjustable
module only)

100 million

Module body 100 million

Piston needle 50 million

Piston seal 30 million

Seal pack 10 million

Nozzle 100 million

NOTE:  To preserve solenoid life, Nordson Corporation recommends
setting the values for GUN ON TIME and GUN OFF TIME at 7 ms or
greater.
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Dimensions 

Figure 37 Robot dimensions (robot part 1094180 shown)
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Applicator Dimensions 

218.34
8.60

218.34
8.60

144.46
5.69

Figure 38 Unity PURJet 30 applicator dimensions

Applicator Cordset Pin Positions 

RTD

HEATER

GROUND

RTD

HEATER

Figure 39 Pin positions on a nickel applicator cordset
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Diagram of Internal Pneumatic Connections 

(AIR REGULATOR)

(SUPPLY AIR)

(EXHAUST PORT)

(OUT PORT)

(SUPPLY AIR)

(EXHAUST AIR)

( SOLENOID VALVE )

TUBING PROVIDED IN SHIP‐WITH KIT

Figure 40 Diagram of internal pneumatic components
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Unity Controller Board Configuration Switch Settings 

2

1

Figure 41 Unity controller board configuration switch settings

1. Unity controller board 2. Location of the IN configuration
switches
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Schematic 

The schematic on the next page is provided for your reference as needed.
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Figure 42 Unity system schematic
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